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LIFE SUPPORT POLICY 
ZILOG’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPO- 
NENTS IN LIFE SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS 
PRIOR WRITTEN APPROVAL OF THE PRESIDENT AND GENERAL COUNSEL OF 
ZILOG CORPORATION. 

 

As used herein 
Life support devices or systems are devices which (a) are intended for surgical implant 
into the body, or (b) support or sustain life and whose failure to perform when properly 
used in accordance with instructions for use provided in the labelling can be reasonably 
expected to result in a significant injury to the user. A critical component is any 
component in a life support device or system whose failure to perform can be reasonably 
expected to cause the failure of the life support device or system or to affect its safety or 
effectiveness. 

 

Document Disclaimer 
©2021 Zilog, Inc. All rights reserved. Information in this publication concerning the 
devices, applications, or technology described is intended to suggest possible uses and 
may be superseded. ZILOG, INC. DOES NOT ASSUME LIABILITY FOR OR PROVIDE A 
REPRESENTATION OF ACCURACY OF THE INFORMATION, DEVICES, OR 
TECHNOLOGY DESCRIBED IN THIS DOCUMENT. ZILOG ALSO DOES NOT ASSUME 
LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT RELATED IN ANY 
MANNER TO USE OF INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED 
HEREIN OR OTHERWISE. The information contained within this document has been 
verified according to the general principles of electrical and mechanical engineering. 

Z8 Encore!, Z8 Encore! XP, ZMOTION, eZ80Acclaim! and ZNEO are trademarks or 
registered trademarks of Zilog, Inc. All other product or service names are the property of 
their respective owners. 

  

Warning: DO NOT USE THIS PRODUCT IN LIFE SUPPORT SYSTEMS. 
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Overview 

Zilog’s Encore! Smart Cable (ZUSBESC0200ZACG) is used to download program and debug systems 
based on Z8Encore! and Z8 Encore! XP microcontrollers using the ZDSII Z8 Encore! version 5.6.0 (and 
later releases).  
   
This user manual provides instructions for installing the ESC hardware and its associated drivers and 
introduces user to debugging process with it. Also, this document provides information about connection 
of the ESC to the target system including necessary connector pinout and signals description 
After completing installation and hardware setup, application firmware can be downloaded to the target 
and debugged using the ZDSII IDE as described in the relevant development kit documentation. 

Place in development process 
ESC is a Hardware and Software interface between Host computer running ZDSII and System Under 
Development. See picture below. 
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Abbreviations and Acronyms 

ESC Encore! Smart Cable 

IDE Integrated Development Environment 

ZDS Zilog Development System, IDE 

DBG Debug Interface/Connector or one of the wires in 
DBG interface/connector. Depends on the 
context. 

SMR Stop Mode Recovery 

OCD On-Chip-Debugger, silicon module on the chip 
responsible for communication with debugger 
(ESC) 

T_MSG Target Message. One of the signals in DBG 
interface 

T_VDD Target power 
 

 

Kit contents 
• Encore! Smart Cable, part number ZUSBESC0200ZACG 

• 6-conductor flat cable 

• USB-A to mini-B cable 

• Encore! Smart Cable Flyer (FL0197) 
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Operating conditions 

When target powered by ESC 
Operating temperature: 25°C +/- 10° 
Minimum T_VDD 1.8V 
Maximum T_VDD  3.6V 
Maximum Current supplied to target 100mA 
Maximum measured current  30mA 
Current measurement resolution  0.01mA 
When powered by external power supply 
Operating temperature: 25°C +/- 10° 
Minimum T_VDD 1.8V 
Maximum T_VDD  3.6V 

 

System Requirements 

The Encore! Smart Cable is a high-power device requiring up to 125mA of current when powering target 
system at maximum current. 

 

 

 
 

 

 
 

 
 

 

USB Port Requirement Full-Speed USB 1.1 (or higher) 

Supported Operating Systems 
Windows 10 (32-bit and 64-bit) 
Windows 8 (32-bit and 64-bit) 
Windows 7 (32-bit and 64-bit) 
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Features 

• Supports target system clock frequencies between 4kHz and 24MHz at OCD baud rates of 
up to 500kbps. 

• Provides up to 100mA of current to target systems before an external power source is 
required.  

o Target operating voltage can be configured in steps of 100mV between 1.8V and 
3.6V. 

• Measures target current consumption (up to 30mA) under control of the ZDSII IDE to provide 
a numerical result on demand, or a graphical output of measurements at 1ms (or longer) 
intervals. 

o Optional breakpoint can be enabled to trigger once the target current consumptions goes 
above, or below, a configurable threshold. 

• Allows target application block OCD communications while in stop mode or performing critical 
operation. This can be accomplished via RESET- pin or new signalling pin named T_MSG, 
based on project configuration. 

o This feature can be used to enable debugging Encore! targets as they transition through 
stop mode without causing a power-on-reset event(1). 

For more information regarding these features, refer to the ZDSII Help file integrated with the 
ZDSII Encore! 5.6.0 (and later) IDE. 

 

(1) Requires the application to drive the appropriate signalling pin (T_MSG or RESET-) 
low prior to entering stop mode. During the SMR the signalling pin should be driven 
high, (if using T_MSG), or configured as the reset alternate function, driven high, (if 
using RESET-). 
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Setup 

The ESC drivers are bundled with the ZDS II Z8 Encore! version 5.6.0 (and later) installation program 
available for download by clicking the following link: Software Downloads 
During installation of the ZDSII Z8 - Encore! 5.6.0 (or later) IDE, the user is prompted to install the ESC 
drivers. By default, the necessary driver files will be installed.  

These drivers must be installed before ESC can be used. 

After installation of all drivers ESC can be connected to the host computer and in the Device Manager 
window one should see following: 

 

Connecting to target system  

ESC is connected to target system through 6-pin connector, located at the side of the ESC opposite to 
the USB connector. This is Amphenol connector PN 75867-131LF. It has 2.54mm spacing between pins 
and rows. Below is description of the pins of connector. 

Pin # Signal name Signal description 

1 T_VDD Target VDD. This pin is target power connection between ESC and target 
system. ESC could be source of the target power, or this signal informs ESC 
that target power is present/absent if ESC was not selected as a source for 
target power. 

2 RESET- Reset, active low. This is used by the ESC to place target into reset state 
before the program can be downloaded. 

3, 5 GND Power Ground. 

4 DBG This is a bidirectional signal that provides communication between ESC and 
target MCU.  

6* T_MSG This signal, when driven LOW by target MCU informs ESC that target had 
entered STOP mode. While this signal is low there is no communications 
between ESC and target initialized by ESC. When target exits STOP mode it 
drives this signal HIGH to inform ESC about change in its status.  

  * Leave this pin unconnected on target system, so that it can be connected to any of the available pins 
 of the MCU.  

 

 

https://zilog.com/index.php?option=com_zcm&task=sdlp&Itemid=74�
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To avoid unexpected when connecting ESC to the target system always follow the procedure 
described below.  

When target system is powered by ESC: 

1. Connect ESC to the host computer using USB-A to mini-B cable 
2. Connect 6-pin flat cable to ESC 

3. Connect the other end of the 6-pin cable to the target system 

When target system is powered by external power supply: 

1. Repeat steps 1 through 3 from above 

2. Apply power to the target system 

Power connection to the target board 
When using the ESC to provide power to the target that has its own local power source, it is 
recommended to isolate the local source from ESC by jumper or zero-ohm resistor. 

DBG interface on the target board 
When designing board with Zilog Encore! or Encore! XP device please follow schematic shown below. 
That will provide the most robust connection between ESC and target MCU. 

Encore! or Encore! XP 
microcontroller

1

3

5

2

4

6

DBG
RESET-

T_MSG

GND

T_VDD

VDD

10KΩ 10KΩ

 

LED function 
There is an LED on the top side of the ESC enclosure. When ESC is powered up, it shines steady yellow 
light to indicate that power is on and that the device was recognised by USB host and enabled to be used 
as USB device. If host was unable to enumerate the ESC the LED will stay off. 

The LED will flicker when ESC is communicating with the target.  
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Downloading code and debugging 

When measuring current consumed by the target, remember that ESC provides power to the target 
through pin 1 of the connector. If the entire target board is using the same power source as the Encore! 
device, the current measured by the ESC and displayed by the GUI will reflect total current consumed by 
the Encore! device and all other components mounted on the board. 

Before you can download your code into the System Under Development you must configure your tools – 
ESC. To do that follow steps listed below. 

1. Open ZDSII IDE on the host system. 

2. Navigate to your project: 
 File > Open Project – locate your project and open it. 

3. Find the development tool you are using by navigating as follows: 
 Project > Settings > Debug Tool > Setup, should appear like the below image: 

  
  

The serial number will be different, hit OK at this screen. 

Now you are ready to download code and start debugging. 
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4. Optionally, Application Stop Mode Signaling feature maybe used as below: 

a. None - If the application does not enter stop mode or does not need to block OCD 
communications while in stop mode. 

     

 

b. T_MSG - if the application is using T_MSG to signal when it’s in stop mode, then ‘Application 
Stop Mode Signaling’ should be configured as shown below: 

    

 If using T_MSG (connected to say PJ3 on anF6482 MCU): 

- On startup and after SMR, configure PJ3 as a high-level GPIO output.  The example 
below configure PJ3 for open drain operation, but this is not necessary due to open drain 
level shifters on ESC board: 
/* 
* Configure PJ3 as TMSG signal pin 
*/ 
PJOC  |=  BIT3; 
PJPUE |=  BIT3; 
PJOUT |=  BIT3; 
PJDD  &= ~BIT3; 

- Prior to entering stop mode, drive T_MSG low: 
PJOUT &= ~BIT3; 
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c. nRST - if the application is using nRESET to signal when it’s in stop mode, then 
‘Application Stop Mode Signaling’ should be configured as shown below: 

     
 
 If using nRST for stop mode signaling: 

- On startup and after SMR, configure PD0 (nRST) for alternate function mode to operate 
as the reset pin: 
   /* 
    * Configure PDO as the reset pin with open-drain and internal 
pull-up 
    */ 
   PDAFS1 &= ~BIT0; 
   PDAF   |=  BIT0; 
   PDOC   |=  BIT0; 
   PDPUE  |=  BIT0; 

- Prior to entering stop mode configure PD0 as low-level GPIO output: 
   /* 
    * Drive PD0 low to indicate the device is entering stop mode. 
    */ 
   PDOUT &= ~BIT0; 
   PDDD  &= ~BIT0; 
   PDAF  &= ~BIT0; 
 
   asm( "STOP" ); 
   asm( "NOP" ); 
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Troubleshooting 

Manual installation of the ESC driver 
In case there is a need to manually install ESC driver do the following: 

1. Navigate steps: 

Window prompt > Programs > Zilog > Zilog ZDSII- Z8Encore! 5.6.0 >  

Right click on the “Install Encore! Smart Cable Driver” and select option “Run as administrator”. 

 

 

Firmware version of the ESC could be seen in ZDSII “Debug” tab once the project was configured with 
proper debugging tool and code is downloaded into the target or connection was made with the target 
see below 

 

  

If there is a new FW releases or ESC had malfunctioned the FW update is possible by following steps 
listed below. 

1. From ZDSII GUI select: Tools > Firmware Upgrade (selected debug tool) 
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2. Once selected you should see a popup 

 

You can select “Verify F/W”, or if new firmware is available “Upgrade”. Then follow prompt as it being 
verified or upgraded. 
 

If a hardware failure is suspected, contact support.zilog.com for assistance. In all other cases follow 
steps listed below.  

  

https://zilog.com/index.php?option=com_product&task=tech_support&Itemid=88�
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Encore! Smart Cable not recognized 
To determine if the Encore! Smart Cable has been detected, open Windows Device Manager and, if 
present, expand the Xtools Usb Devices (ZiLOG) section as shown below: 

 

 

If the “Xtools Usb Devices (Zilog)” line is missing or “Encore! Smart Cable” is not listed, try 
disconnecting the ESC from the USB port on the host PC and connecting it to a different USB port. If 
the ESC is still not recognized try the following: 

• Connect the ESC to a USB port on the host PC versus an external hub 

• Reinstall ESC drivers manually 

• Disconnect all other USB devices (including your keyboard and mouse).  If this resolves 
the problem, reconnect the other devices, one at a time, to isolate the conflicting device. 

• If none of the above works, try using different PC 

• If still no success contact Zilog Customer Support support.zilog.com 

 
  

https://zilog.com/index.php?option=com_product&task=tech_support&Itemid=88�
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Revision History 

Each instance in this document’s revision history reflects a change from its previous 
edition. For more details, refer to the corresponding page(s) or appropriate links 
furnished in the table below. 

Date 
Revision 
Level Description Page 

Dec 2020 01 Original issue. All 

Jan 2021 02 Added “Power connection to the target board” Page 6 

Feb 2021 03 Added a paragraph under Downloading code and debugging Page 7 

Customer Support 

To share comments, get your technical questions answered, or report issues you may be 
experiencing with our products, please visit Zilog’s Technical Support page at support.zilog.com. 

To learn more about this product, find additional documentation, or to discover other facets about 
Zilog product offerings, please visit the Zilog Knowledge Base. 

This publication is subject to replacement by a later edition. To determine whether a later edition 
exists, please visit the Zilog website at www.zilog.com. 

 

https://zilog.com/index.php?option=com_product&task=tech_support&Itemid=88�
http://www.zilog.com/kb�
https://www.zilog.com/index.php?option=com_tech&task=kb&Itemid=84�
http://www.zilog.com/�
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